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Feature overview 

 
Fiery JobExpert is a breakthrough new technology that analyzes incoming PDF files and dynamically 
chooses the optimal print settings to achieve the highest quality, while optimizing production time. 
 
To accomplish this, Fiery JobExpert will:  

• Analyze each PDF print job in detail. 

• Automatically set the optimal Fiery job settings. 

• Process each job to efficiently achieve the best possible print quality. 

 

JobExpert serves as a built-in expert that delivers:  

• Highest print quality 

• Faster processing 

• Enables less-experienced operators to run jobs correctly 

• Reduces setup time 

• Cuts waste 

• And can be undone if needed 

Objectives 

• Import a document using Fiery JobExpert in Fiery Command WorkStation® 

• Check the automatic corrections applied by JobExpert. 

• Apply Fiery JobExpert to a job already imported in the Held queue. 

• Clear Fiery JobExpert settings applied to a job. 

• Preview Fiery JobExpert Report applied to a job. 

Additional resources 

For additional software downloads, training resources, and more, go to Fiery Online Resources. 

Before you begin 

• Open Fiery Command WorkStation® 6.7 or newer. Connect to a Fiery Driven™ printer running Fiery 
FS500 / FS500 Pro system software or newer. 

• Have a copy of the files on your desktop: efi_fiery_MnM_booklet_jobexpert_A4.pdf or 
efi_fiery_MnM_booklet_jobexpert_LTR.pdf. 

• Ensure that the printer and Fiery server have been calibrated before printing any output.  

http://efi.com/resources/fiery-online-resources/
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Import a document using Fiery JobExpert in Fiery Command WorkStation 

 

In this section you will import a PDF file to Fiery Command WorkStation, apply JobExpert to it, and then 
import the same file without JobExpert applied for later comparison. 

For the first PDF file, JobExpert will choose the optimal Job Properties settings based on the content of the 
job.  

 

1. To begin, import the efi_fiery_MnM_booklet_jobexpert_LTR.pdf or 
efi_fiery_MnM_booklet_jobexpert_A4.pdf file to the Fiery server using Command WorkStation. 
Select the File menu and then choose the Import job… option. Alternatively, you can use the Import 
toolbar icon located in Job Center. 

 

Note: Depending on the media stock size that you have available on your Fiery server trays, you can 
select the A4 version of this file, the JobExpert results will be the same. 

2. In the new window, Select Files to Import, select the PDF file located on your Desktop and then click 
Open.  

3. A new window called Import Files will appear showing the PDF’s file name, size, and type.  
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4. Click on the Apply JobExpert checkbox located in the lower-left corner of this window.  

 

5. After clicking the checkbox, a drop-down list selection will be activated. For this example, leave the ‘All 
categories’ option selected. JobExpert will choose the best Job Properties settings based on the 
content of the job. 

 

Note: When the All categories option is selected, Fiery JobExpert automatically sets the correct print 
settings for color management, image quality, variable data, and some engine-specific properties. 

• When Color Management is selected, JobExpert will choose the best color settings based on the 
content of the job. After the job is analyzed by JobExpert, you can check the applied settings by 
opening the Color tab in Job Properties. If needed, JobExpert will also enable Adobe PDF Print 
Engine (APPE) in the job. 

• Using the Image Quality option, JobExpert will choose the best image quality settings based on the 
content of the job. After the job is analyzed by JobExpert, you can check the applied settings by 
opening the Image tab in Job Properties. 

• When VDP option is selected, JobExpert will choose the best settings in Job Properties for PDF jobs 
that contain variable data. If PDF/X objects are detected in the job, JobExpert will also enable APPE. 

 

6. Then, select Process and Hold job action, and JobExpert will automatically apply the recommended 
settings to that job. 

 

Now, you will import the same file one more time, but you will not use Fiery JobExpert. 

1. Select the File menu and then choose Import job… option. Locate the PDF file 
efi_fiery_MnM_booklet_jobexpert.pdf on your Desktop and select it. 

2. In the new Select Files to Import window, click Open.  

3. A new window called Import Files will appear, don’t change any of the settings and click the Process 
and Hold button. 

Look at the Held queue, you will see the PDF file, efi_fiery_MnM_booklet_jobexpert.pdf, listed twice. 
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Check the automatic corrections done by JobExpert 

 

In this section, you will see how JobExpert settings can be applied to PDF files imported into Fiery Command 
WorkStation. 

EFI has developed extensive checks to detect embedded ICC profiles, transparency issues, small texts and 
ultra-thin lines. 

To check some of these settings and corrections, you can use Preview in Fiery Command WorkStation, 
however some corrections can only be checked on a printed document. 

Using the Preview option, you can visually check if an embedded ICC profile was correctly honored using 
JobExpert on a Fiery server. 

JobExpert will detect profiles in incoming PDF files whether they are RGB, CMYK, gray — or even when there 
is an embedded output intent profile. Let’s see how to check that. 

 

1. Locate the latest imported PDF file efi_fiery_MnM_booklet_jobexpert.pdf that was processed 
without Fiery JobExpert in the Held queue. 

2. Do a right-click on it. 

3. From the context menu, select the Preview… option. 

4. At the bottom of the first page, you will see two pictures. The one on the right of the page has a 
custom CMYK ICC embedded profile that was not processed properly. You can visually see that the 
image has a magenta cast. 

 

 

Image processed without JobExpert. 

 

Now, compare the same PDF that was processed using Fiery JobExpert. 

1. Locate the first imported PDF file efi_fiery_MnM_booklet_jobexpert.pdf that was processed using 
Fiery JobExpert in the Held queue. 

2. Right-click on the PDF. 

3. From the context menu, select the Preview… option. 
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4. Take a look at the two pictures at the bottom of the first page again. The image on the right has a 
custom CMYK ICC embedded profile. Now with JobExpert applied, the image was processed 
correctly with the embedded ICC profile and there isn’t a magenta color cast. 

 

Image processed with JobExpert applied. 

 

To compare which settings were used for each job, we can compare the job properties for these two 
examples. 

1. Select the two jobs efi_fiery_MnM_booklet_jobexpert.pdf in the Held queue that were used in the 
previous examples. 

2. Right-click on one of them. 

3. Select the Properties option from the context menu. 

4. Then click on the Summary tab. 

5. In the Color section you can check all the settings that were configured based on the PDF content. 
For example, you can see that the setting ‘Use CMYK embedded profiles’ is set to ‘Off’ and ‘On’ for 
each processed PDF. 

 

 Without JobExpert  With JobExpert  
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Fiery JobExpert can also correct several other settings including: 

Color Spaces and Spot Colors 

 

Without JobExpert 

 

With JobExpert 

  

  

Without JobExpert With JobExpert 

  

Transparencies 

  

Without JobExpert With JobExpert 

  

Small text 

  

Without JobExpert With JobExpert 
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Ultra thin-lines 

  

Without JobExpert With JobExpert 

  

Enable APPE to ensure correct output 

  

Without JobExpert With JobExpert 

  

Apply Fiery JobExpert to a job already imported on Held queue 
 

In this section, you will see how to apply JobExpert settings to a PDF file that was already imported, without 
using the Fiery JobExpert feature. 

1. Locate the job you want to apply JobExpert in the Held queue. 

2. Right-click on the job name. 

3. From the context menu, choose Apply JobExpert option.  

4. Choose All categories from the pre-defined settings available. 
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Fiery Command WorkStation will automatically apply JobExpert to the selected PDF file, and will show a 
progress bar in the Job Status column of the Held queue. 

 

  

 

Note: You can only apply Fiery JobExpert to any job that has not been processed yet. It’s necessary to 
remove the raster data from a processed job before applying JobExpert. Select the processed job file in the 
queue, right-click on it and select the Remove Raster option from the context menu. 

 

Clear Fiery JobExpert applied to a job 

 

If you need to undo the JobExpert settings for any job, you can remove this feature with just one click. 

1. Locate and select the job you want to remove the JobExpert settings from in the Held queue.  

2. Right-click on the job name. 

3. From the context menu choose Clear JobExpert option.  

Fiery Command WorkStation will automatically revert to the previous settings for the selected PDF file in the 
Held queue. 

 

Alternatively, you can also clear the JobExpert setting using the Summary Panel.  

1. Locate and select the job you want to remove JobExpert settings in the Held queue. 

2. From the Summary Panel area, click on the Clear link.  

Fiery Command WorkStation will automatically clear the JobExpert settings on the selected PDF file in the 
Held queue and assign the default settings. 

Note: You can only clear Fiery JobExpert for a job that is not processed. Therefore, it’s necessary to 
remove the raster data from a processed job. Select the processed job file in the queue, right-click on it 
and select the Remove Raster option from the context menu. 
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Preview Fiery JobExpert Report applied to a job 

 

After applying JobExpert to a job, you can use the JobExpert Report to see a summary and explanation of the 
settings optimized for the job. Plus you can use the preview functionality to visualize the elements that require 
specific settings to be enabled. 

There are two ways to access the JobExpert Report. The first is to right-click the job’s name in the job queue 
and choose the View Report from the context menu. The second is to click on the View Report link under the 
JobExpert information in the Job Summary area.  

 

Once the report is open, you can see which preset was used and settings that were optimized by JobExpert. 

Also, you can view the explanation about each setting applied and how many instances it was applied to. 

If you click on a setting that was enabled, a new window will pop up to show you the elements that required 
the setting to change within the document. You can cycle through the settings preview by clicking on the 
Previous or Next buttons, selecting a different zoom factor, and also changing the background color to assist 
in viewing the elements that were affected in the document. 

           



 

 

Nothing herein should be construed as a warranty in addition to the express warranty statement provided with EFI products and services. 

The APPS logo, AutoCal, Auto-Count, Balance, BESTColor, BioVu, BioWare, ColorPASS, Colorproof, ColorWise, Command WorkStation, CopyNet, Cretachrom, Cretaprint, 

the Cretaprint logo, Cretaprinter, Cretaroller, Digital StoreFront, DirectSmile, DocBuilder, DocBuilder Pro, DockNet, DocStream, DSFdesign Studio, Dynamic Wedge, EDOX, 
EFI, the EFI logo, Electronics For Imaging, Entrac, EPCount, EPPhoto, EPRegister, EPStatus, Estimate, ExpressPay, FabriVU, Fast-4, Fiery, the Fiery logo, Fiery Driven, the 
Fiery Driven logo, Fiery JobFlow, Fiery JobMaster, Fiery Link, Fiery Navigator, Fiery Prints, the Fiery Prints logo, Fiery Spark, FreeForm, Hagen, Inktensity, Inkware, LapNet, 
Logic, Metrix, MicroPress, MiniNet, Monarch, OneFlow, Pace, Pecas, Pecas Vision, PhotoXposure, PressVu, Printcafe, PrinterSite, PrintFlow, PrintMe, the PrintMe logo, 

PrintSmith, PrintSmith Site, PrintStream, Print to Win, Prograph, PSI, PSI Flexo, Radius, Remoteproof, RIPChips, RIP-While-Print, Screenproof, SendMe, Sincrolor, Splash, 
Spot-On, TrackNet, UltraPress, UltraTex, UltraVu, UV Series 50, VisualCal, VUTEk, the VUTEk logo, and WebTools are trademarks of Electronics For Imaging, Inc. and/or its 
wholly owned subsidiaries in the U.S. and/or certain other countries. 

All other terms and product names may be trademarks or registered trademarks of their respective owners, and are hereby acknowledged. 

© 2022 Electronics For Imaging, Inc. All rights reserved. | WWW.EFI.COM  

We develop breakthrough technologies for the manufacturing of signage, packaging, 

textiles, ceramic tiles, building materials and personalized documents, with a wide 

range of printers, inks, digital front ends, and a comprehensive business and 

production workflow suite that transforms and streamlines the entire production 

process, increasing your competitiveness and boosting productivity. Visit 

www.efi.com for more information. 
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